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What is Vocabulary Wizard and what can it do? 
Vocabulary Wizard is a vocabulary learning tool for Windows, Windows 95 and Windows NT.    
Vocabulary Wizard gives you an efficient, fast and easy way to study words. It was made for you and your 
friends or your students or your children who prepare for English vocabulary-related examinations such 
as the SAT, GRE, ACT, TOEFL, and so on.

Vocabulary Wizard has a built-in dictionary of over 6,000 carefully chosen words that appear 
frequently on standardized tests. Moreover, you are not limited to these 6,000 words; you can edit the 
dictionary and even add your own words to it. The data for each word in the dictionary consists of the 
following 9 components: (word), (pronunciation), (part), (origin), (meaning), (2nd meaning), (example), 
(2nd example), and (reference). In the near future, Vocabulary Wizard will provide you with various 
methods of creating your own dictionary. So you can make your own wordlists and share them with 
others.

Each word in the Vocabulary Wizard's dictionary has its own specific attributes: Study index, 
Check mark, and Master mark.    The Study index of a word indicates how many times you have 
correctly answered test questions of that word.    At the beginning of a test, all the Study indices of the 
words are 0.    As your study progresses, the Study index of a word may be changed as a result of your 
answer. It can have one of the numbers between -3 to +3 as its value. For example, if your answer is 
correct once, the corresponding Study index will be +1. If wrong, it will be -1. If    you are correct twice, it 
will be +2.    If wrong three times, it will be -3 and so on. But the way to update it is not always proportional 
to the count number of the correct answers because Vocabulary Wizard also considers the frequency of 
the correct answers during the Study index update.    Anyway, if all the Study indices reach +3, you may 
think that your study of the words is successful and perfect.    A Check mark of a word can be given or 
removed by a user.    If you meet an unfamiliar word or a word needs to be reviewed more, you can add a 
Check mark to it for later use.    By doing this, you can collect the words with Check marks only and study 
them intensively. You can even save them into a special wordlist and print it on paper.    A Master mark of 
a word is the opposite of a Check mark.    If you already know a word very well, you can give a Master 
mark to the word.    After that, it will be considered as a trivial word that you don't have to study any more. 
Vocabulary Wizard usually ignores the words with Master marks while creating test questions. Of course, 
you can remove the Master mark at any time.    In order to achieve a faster enhancement of your 
vocabulary ability, you should concentrate on the words whose Study indices are below 0 (i.e. -1, -2, -3.) 
and which have Check marks.

Vocabulary Wizard supports up to 3 users.
For each user, there are two user-specific files: *.usr and *.smk.    A *.usr file has the information about a 
users name, font settings, and other option settings.    A *.smk file holds the study record of a user.    
Vocabulary Wizard saves and retrieves all the user information.    You don't have to worry about any loss 
of information.    When Vocabulary Wizard has been installed on a hard disk, three individuals can enjoy 
their own studies at the same time. You can edit your information and reset your study records at any 
time. The only thing you have to do is to select your username as a current user in the User menu.

Vocabulary Wizard offers three screens: the Desk, Study, and Test screens.
In the bookstand of the Desk screen, you can pick wordbooks or wordlists you wish to learn and then put 
them on the desk. This is the first step for preparing your study. After setting up the desk, you can go to 
the Study screen or the Test screen.
In the Study screen, Vocabulary Wizard presents you with a flashcard slide-show of words. It gives you a 
variety of options to customize your study. You can adjust the display frequency. You can make some 
components visible or invisible on the screen. You can even extract only the words with a specific Study 
index or a Check mark from the desk and list them by the specified order.    As mentioned above, you can 
save and print wordlists easily. You can insert the saved wordlist as a new wordlist into the bookstand. 
You can directly put it on the desk even without creating a new wordlist.
In the Test screen, Vocabulary Wizard generates various test questions from the wordbooks on the desk. 
In the test option dialog box, you can choose a test style and the attributes (a Study index, a Check mark, 



and a Master mark) of the words in the test.    There are three test styles: Test1 (word-to-meaning multiple 
choice), Test2 (meaning-to-word multiple choice), and Test3 (spelling exercise). You can make Vocabulary 
Wizard offer questions only for the words whose Study indices are below 0. You can refer to the dictionary 
at any time for your further study. You can even print a series of questions and corresponding answers 
into plain text files.

Sounds complicated?    Don't worry. Vocabulary Wizard is also easy to use.    You can quickly learn how 
to navigate from screen to screen, and Vocabulary Wizard offers a variety of keyboard and mouse 
shortcuts and a nice toolbar. If you get into trouble or can't figure out how to do something, just look at 
these Help topics, or send an email to ddam@nownuri.net. Vocabulary Wizard is quite the thing!    Once 
you've studied with it for a while, you'll see how much it can help you prepare for exams.



Desk & Bookstand

In the desk screen, Vocabulary Wizard lets you prepare your vocabulary study. You can also manipulate 
data related to the bookstand and the dictionary.

Basic Procedure:

Select a wordbook or a wordlist that you wish to study in the bookstand. The bookstand is 
featured as a tree structure.    Double-click a wordbook if you want to unfold or fold it.

Click > button. The selected wordbook or wordlist will be loaded on the desk. In case of a 
wordlist, you can also put it on the desk with double-clicking it.    In order to unload a wordbook (or a 
wordlist) from the desk, select it and click < button.    You can load as many wordbooks (wordlists) as you 
like at the same time.

LCD panel shows you the attribute statistics of the wordbooks (wordlists) on the desk. Those 
numbers indicate how many words with a certain Study index (or with a Check mark or with a Master 
mark) there are on the desk. (no double-counting of a same word)

Now, are you ready? Go to the Study screen or the Test screen!

See also:

Loading a wordlist file on the Desk
Inserting a wordbook (or a wordlist)
Filling a wordlist
Importing a pronunciation data



Loading a wordlist file on the Desk
You can load up to 3 wordlist files directly onto the Desk at the same time.
Before loading the wordlist files (*.wlf), they should be created and be prepared in the Study screen.

1 Click WLF> button on the Desk screen.
2 Choose one of the wordlist files in the file dialog box, and click OK.
3 Then the file is loaded on the Desk.
4 You can create new wordlists of the Bookstand from wordlist files. Refer to See also topics.

See also:

Inserting a wordbook (or a wordlist)
Filling a wordlist
Saving a wordlist



Inserting a wordbook (or a wordlist)
You can insert a new wordbook or a new wordlist to the bookstand.

1 Select an existing wordlist or wordbook in the bookstand. Then you can insert a new wordbook or a 
new wordlist to the next of the selected one.

2 On the Data menu, click Insert Wordlist. 
3 In the Insert Wordlist dialog box, type the title, select the type, select the depth, and then click OK.
4 If you insert a wordlist, the Fill Wordlist dialog box will be display automatically.

See also:

Filling a wordlist
Inserting a word to the wordlist



Filling a wordlist
You can fill an existing wordlist (that is probably empty or is to be updated) with new word entries.

1 Select an existing wordlist (not a wordbook) in the bookstand.
2 On the Data menu, click Fill Wordlist.
3 In the Fill Wordlist dialog box, select the fill options that you want, and then click Fill.
4 In the Open Wordlist Source File dialog box, select the wordlist source file (*.wlf, or *.vtx) that has the 

word entries with which you want to fill the wordlist, and then click OK.
5 You can repeat 3,4 as many as you want. The total count number of the words that the wordlist has will 

be displayed on the dialog box.
6 After filling it, click Save, and then click Close.

See also:

Inserting a wordbook (or a wordlist)
Inserting a word to the wordlist



Importing a pronunciation data
You can import additional voice pronunciation data into the Dictionary. Prosigner will provide you the data 
files (*.pdf) through its home page (www.prosigner.com). Finally all the pronunciations of the words in the 
dictionary will be served as CD-ROM media.    At that time, this feature will be obsolete or rarely used.

1 On the Data menu, click Import Pronunciations.
2 Select the pronunciation data file (*.pdf).
3 Then Vocabulary Wizard maps the voice data into the words in the dictionary automatically for you.



Study

In the study screen, Vocabulary Wizard presents you a flashcard slide-show of words that come from the 
wordlists on the desk or the recently used wordlist.    You can specify the attributes of the words that can 
be shown in the screen.    You can set slide-show parameters (e.g. frequency, delayed meaning display, 
visible components of words) as you like.    After setting the options, you can play the slide-show 
automatically or manually. You can even print the wordlist on a paper. Vocabulary Wizard gives you 
comfortable functionality to review words and check your knowledge of them as fast as possible.

Basic Procedure:

In the Study Options dialog box:
- Select a wordlist source and the attributes of the words to be shown.
- Select a method by which the words are sorted.
- Set the other options.
- Click OK button.
- Based on the above selections, Vocabulary Wizard creates a temporary wordlist for a slide-show.
- The first word of the wordlist will be displayed on the screen.

Click > button or press the RIGHT arrow key to see the next word.
Click < button or press the LEFT arrow key to see the previous word.
You can specify visible components of a word through the toggle buttons at the bottom of the 

screen.
You can adjust the frequency of a slide-show on the fly.

If you find unfamiliar words, add a Check mark by clicking Check mark on the toolbar or pushing 
GRAY + key on the numeric keypad.

If you wish to remove a word from the current wordlist, push GRAY - key on the numeric keypad. 
This action is different from adding a Master mark.
 

By clicking Auto, Vocabulary Wizard play the slide-show automatically.    To stop it, click Stop.

Items (Numbers and Buttons) at the bottom of the screen:

Number (left) Indicates the total count number of the words in the current wordlist
[<] Goes to the previous word
[>] Goes to the next word (step)

[Auto/Stop] Plays/Stops the slide-show
Number (middle) Indicates the interval period between a word and a word in 0.1 second unit (you 

can adjust this number by clicking the up/down allow buttons next to it.)

[d] button Delays displaying word meanings, examples, and references
Number (right) Indicates the duration period between showing a word spelling and showing rest 

components (you can adjust this number by clicking the up/down allow buttons 



next to it.)

[p] Makes (pronunciation) visible
[o] Makes (origin) visible
[m1] Makes (meaning) visible
[m2] Makes (2nd meaning) visible
[e1] Makes (example) visible
[e2] Makes (2nd example) visible
[r] Makes (reference) visible

[bc] Change the background color of the screen

Keyboard and Mouse:

GRAY + Toggles Check mark
GRAY - Removes a word from a slide-show wordlist
Ctrl+I Toggles Check mark
Ctrl+M Adds Master mark
F7 Displays the Study Options dialog box
LEFT Goes to previous word
RIGHT Goes to next word
DOWN Goes to next word (step)
ENTER Goes to next word (step)
SPACE Goes to next word (step)
F10 Sounds voice pronunciation
RIGHT (MOUSE) Goes to next word (step)

See also:

Printing a wordlist on paper
Saving a wordlist
Inserting a word to a wordlist



Printing a wordlist on paper
You can print the current wordlist of the Study Screen on paper.

1 Click Print Wordlist on the Study menu, or click Print on the toolbar.
2 Select the printing items, the number of columns, fonts size, margins, and header.
3 To select the output printer or set paper size, click Printer Setup on the User menu.
4 To preview, click Preview. To print, click Print.

See also:

Printing questions to a text file



Saving a wordlist
You can save the current wordlist of the Study screen at any time.

1 Click Save Wordlist on the Study menu, or click Save on the toolbar.
2 In the dialog box appeared, select the options that you want, and then click Save.
3 Type the name of the wordlist file and click OK.
4 What can you do with this saved wordlist file? Please, refer to See also topics.

See also:

Filling a wordlist
Loading a wordlist file on the Desk
Inserting a word to a wordlist



Inserting a word to a wordlist
You can insert a new word entry to the current wordlist of the Study screen.

1 In the Study screen, open the Dictionary with clicking Dictionary on the toolbar.
2 In the Dictionary dialog box, type or find the word that you are going to insert into the current wordlist. 

You can register a new word into the Dictionary if necessary.
3 Click * (asterisk) button.
4 You can insert a new word before or after the current displayed word in the wordlist.
5 You can repeat 2,3,4 as many times as you want.
6 The inserted words are also written down onto VWIZTMP.VTX file automatically for later use. It will be 

helpful when you fill an empty wordlist in the Bookstand.

See also:

Using the Dictionary
Filling a wordlist



Test

Vocabulary Wizard gives you various test questions. It automatically generates them on the basis of the 
Test Option settings. There are three types of the test questions. You can specify the attributes of the 
words that can be questioned.    You can even print questions to a text file for a paper test.    Through this 
session, you can exercise yourself for real tests.

Basic Procedure:

In the Test Options dialog box:
- Select a type of questions and attributes of the question words.
- Select a style of displaying meanings.
- Set the other options.
- Click OK.
- The first question will be displayed on the screen.

In Test1, you should guess a correct meaning of the given word.
In Test2, you should guess a word of the given meaning.
In Test3, you should enter a word of the given meaning.

After a short guess, click a number button or press a numeric key or enter a word and press 
ENTER.

To pass a test question without answering it, click Q or push ENTER key or press RIGHT 
(MOUSE) button.

Then Vocabulary Wizard shows the result of your answer. If you are correct, it gives you O sign. If 
wrong, you are given X sign.

To get more information about words, just click the corresponding number buttons. Then the 
dictionary will pops up with proper information.

Of course, the result is to be reflected on the Study index of the word.
Youd better not hesitate to assign a Check mark or a Master mark whenever you think it is 

needed.

Keyboard and Mouse:

GRAY + Toggles Check mark
GRAY - Toggles Master mark
Ctrl+I Toggles Check mark
Ctrl+M Toggles Master mark
F8 Displays the Test Options dialog box
F10 Sounds voice pronunciation
ENTER Goes to next question
RIGHT (MOUSE) Goes to next question

See also:

Printing questions to a text file



Printing questions to a text file
You can print questions and answers to a text file. The extension of the file is TST which means Test. If 
you create a TST file, a corresponding ANS text file will be automatically created which includes the 
correct answers of the questions.

1 On the Test menu, click Print Questions to a Text File or click Print on the toolbar.
2 In the file dialog box, type the filename of the text file, and then click OK.
3 In the Test File Save dialog box, add question items by clicking Add.
4 When you see Test Options dialog box, select the options, type the number of questions, and then 

click OK.
5 You can repeat 3,4 as many times as you want.
6 To remove a existing question item, select it in the list box, and click Delete.
7 After adding question items, click Save, and then click Close.

See also:

Printing a wordlist on paper
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Changing user information
Vocabulary Wizard supports up to 3 users. Each user has his or her own study records, name, and option 
settings in the corresponding *.usr and *.smk file. You can find the current users name on the applications 
title bar. If you are using Vocabulary Wizard with other users, youd better check if the current user stands 
for you or not before your study.

Changing the current user:

On the User menu, click the users name that stands for you. 

The your study records generally mean Study indices, Check marks, and Master marks of the words that 
you have studied. You can change your name, reset the Study indices to 0, remove Check marks, and 
remove Master marks. You can even limit the changes to the words on the desk not the whole words in 
the dictionary.

Initializing your name and records:

1 On the User menu, click User Properties.
2 To change your name, type a new name in the dialog box.
3 To change your study records, select the options that you want and click Change.
4 You can repeat 3 if necessary.
5 After changing them, click OK.



Fonts Setup
You can all the fonts of the characters that are displayed on the screen.

1 On the User menu, click Fonts.
2 Select the display item in the list box and then click Change.
3 Select a font from the Font dialog box.
4 You can repeat 2,3 as you want.
5 To reset all the settings with the default values, click Reset.



Using the Dictionary
You can refer to Vocabulary Wizards Dictionary at any time. This dictionary plays an important role as a 
database internally and it gives you quick references for unfamiliar words. You can add new words or 
additional information into it. You can edit the existing data.

Components of a word:

(Word) spelling of the word
(Pronunciation) phonetic symbols
(Part) part of speech
(Origin) information of its origin
(Meaning) 1st meaning (mainly in English)
(2nd Meaning) extra meaning or translation of its 1st meaning in foreign languages
(Example) 1st example (mainly in English)
(2nd Example) extra example or translation of its 1st example in foreign languages
(Reference) synonyms [+], antonyms [-]

How to open:

1 Click Dictionary on the View menu or on the toolbar.
2 In the Study screen, it pops up with the current word initially.
3 In the Test screen, it pops up with the answer word. If you want to know details among the words of the 

multiple choices, click the number buttons, then it shows you the corresponding words.
4 If you check or uncheck Max, the size of the Dictionary will become normal or large.

Finding a word:

1 Type the word you want to refer and press ENTER or click Find.
2 If the word already exists in the Dictionary, it will be shown to you. Otherwise, the similar words will be 

listed on the list box. You can click a word item in the list box to see details.
3 If the word has its voice pronunciation data, the Dictionary sounds it at the same time. You can hear it 

again with clicking Voice.

Adding a word:

1 Type the word you want to add and click New.
2 Fill in the data form appropriately as much as you can. See Components of a word. You should check 

at least one part of speech in the Part group box.
3 To type phonetic symbols of the word, refer to Keyboard mappings.
4 After filling, click Save and then click Close.

Editing an existing word:

1 Type the word or find the word whose data you want to edit.
2 Click Edit.
3 Update the existing data or add some contents.
4 After editing, click Save and then click Close.



Arranging whole data:

1 To arrange the index file of the Dictionary, click Arrange.
2 You can even remove redundancies in the data file. But this process will be very lengthy.
3 Youd better arrange the Dictionary once a month.

Keyboard mappings for phonetic symbols:

1 In the above figure, the first row indicates the phonetic symbols and the second row indicates the 
corresponding keys.

2 You can input the first accent(') and the second accent(`) of the word. The second accent(`) should be 
located before a vowel while the first accent(') should be located after a vowel.

3 After typing and saving, Vocabulary Wizard converts the accent symbols into the proper formation.

See also:

Inserting a word to a wordlist



Vocabulary Wizard Registration Information
You can pre-order Vocabulary Wizard by email or at Prosigner's home page. Within 2 business days of 
receiving your order, Prosigner will email a regular registration form and detail information. If you have 
any questions about ordering, please do not hesitate to email Prosigner at ddam@nownuri.net. When 
another registration method is prepared, it will be noticed in Prosigner's home page.

With a Registered Copy:

1 There is no limit on the number of the words that can be loaded on the Desk at a time. In a demo 
version, it is limited to only 7 words.

2 You can even get the upgrade discount continually from us.

Registration Fee (Price):          US$      28.00      (for personal license)

(see License and Copyright for multiple licenses)

Registration Procedure:

1 First!    Email us your pre-order that includes your e-mail address, residence, country and opinion about 
Vocabulary Wizard, or visit our home page, fill in the pre-order form, and then submit it.

2 After getting your pre-order, we'll email you a regular registration form and detail information.
3 You can pay with one of the possible ways: a personal check or money order or cashier's check or with 

an international money order drawn in US dollars.
4 As soon as receiving your payment, we'll send you a registered copy via e-mail file attachment.

Prosigner:
E-mail: ddam@nownuri.net
Home page: http://www.prosigner.com



Other programs from Prosigner
You can find information on Prosigner's other products at http://www.prosigner.com. You can also 
download the latest versions of our shareware products from there:

Memory Wizard:

Memory Wizard is a small-sized Windows95/NT(32Bit) application truly helps you memorize 
whatever you have to learn by heart.

MemWiz pops up periodically with user-prepared questions and answers on your monitor.
For anyone who works on a PC every day.
For anyone who has a lot of things to memorize steadily.
Especially for students and those preparing themselves for examinations!
You don't have to worry about when and how to brush up on your knowledge and wisdom.
MemWiz will take care of your review practice automatically for you.
Enjoy the user-friendly interface of Memory Wizard!

L/C Wizard (Listening Comprehension):

LCWiz is a Windows95/NT(32Bit) application that develops your listening skills in foreign 
languages!

LCWiz records human voice or music from your audio tapes and compact disks into digitally 
remastered files, and provides you with a convenient means to transcribe audio recordings into text.

For anyone who has to learn how to listen to and how to speak foreign languages efficiently and 
comfortably. Especially for students & teachers of foreign languages.

You won't have to wrestle with your cassette player any more.
From now on, you won't need pencils & notebooks to transcribe your recordings.



License and Copyright
Vocabulary Wizard was created by Prosigner.

Software License

Please read the following lines carefully before using this software. If you disagree with any of the 
following, you are not allowed to use this program. You MUST then delete it immediately.

Vocabulary Wizard may be freely distributed subject to the conditions below, but please consider 
registering if you decide to use this program after evaluating the unregistered shareware version.    
Vocabulary Wizard may NOT be distributed in any retail package (Shareware collection or otherwise) 
without written consent of Prosigner.    If Vocabulary Wizard is included in any non-retail CD-ROMs or 
other packages, please let us know so that we can keep track of the distribution.    If you would like to 
include Vocabulary Wizard in a retail package, please contact us for more information.    The registered 
copy granting the full use of all the functions in Vocabulary Wizard may only be used on a single machine 
at any given time.    By receiving a registered copy from us, you are agreeing to this license.    A registered 
copy can only be given out by Prosigner, or an agent acting on behalf of Prosigner officially authorized by 
Prosigner.

Registered version (personal license)

The registered version may be installed on as many computers as desired, as long as it is ONLY running 
on one at any one time (I.e. one installation at home and one at the office used by the same person). The 
usage by multiple people at the same time (on multiple computers) requires additional licenses.

Multiple licenses (additional licenses)

Multiple licenses allow an institution, company or school to install the program on multiple computers or 
on a server. It must be guaranteed that the program does not run on more machines at the same time 
than there are licenses purchased. Additional licenses cost US$ 15.00 for the 2nd to 10th license, etc. For 
larger amounts than 50 please contact Prosigner. Each additional license also allows a single user to use 
the program at home.

Warranty Disclaimer:
Prosigner makes no warranty of any kind, expressed or implied, including any warranties of fitness for a 
particular purpose.    In no event will the company be liable for any incidental or consequential damages 
arising from the use of, or inability to use, this program.

Vocabulary Wizard is a trademark of Prosigner.    Windows, Windows 95, and Windows NT are trademarks or registered trademarks 
of Microsoft Corporation.    All other products mentioned are trademarks or registered trademarks of their respective manufacturers.

See also:

How to register




